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[bookmark: User_Instructions]
	User guidance
[bookmark: OLE_LINK1]The standard form following is for the preparation of a tender document for Consultancy Services: Multiple Tenders
Part 1: Conditions of Tendering
Guide notes
This standard form contains guidance in hidden text, ie:
GUIDE NOTES;
Guide Note examples
Viewing guide notes
1. If the guide notes are not visible, click on the Show/Hide button .
2. If still not visible, then:
•  At the Tools menu;
•  Click Options, and click the View tab;
•  Tick the Hidden Text check box and click the OK button.
Insertion points
Each ‘»’ shows where input is required. Click onto each ‘»’ and overtype.
When completed
1. Remove all guide notes manually or by the following steps:
•  On the Edit menu click Replace, then (if required) 
•  Click the More button;
•  Click the Format button, click on Font;
•  Tick the Hidden check box and click the OK button;
•  Click the Special button, click on Any Character; then
•  Click the Replace All button.
2. Delete this User guidance, along with the following Page Break.
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Consultancy Services: Multiple Tenders

[bookmark: _Toc182198323]Conditions of Tendering
These Conditions of Tendering do not form part of the Agreement.

[bookmark: _Toc182198324]Description of the Services
Include a short, positive and concise description of the work to be carried out under the engagement.
»
[bookmark: _Toc182198325]Contact person
Refer requests for information about the Tender to:
Insert the name and contact details of the person best able to answer tenderers’ questions.
Ensure that the person has a copy of the tender documents and will be available for the duration of the tender period.
	Name:
	»

	Position:
	»

	Agency or firm:
	»

	Telephone number:
	»

	Facsimile number:
	»

	e-mail address:
	»


[bookmark: _Toc182198326]NSW Government Code of Practice for Procurement
Tenderers must comply with the NSW Government Code of Practice for Procurement, which is available at:
www.nswprocurement.com.au/Government-Procurement-Frameworks/Files/code_of_prac-curr.aspx
Lodgement of a tender is evidence of the Tenderer’s agreement to comply with the Code for the duration of any contract awarded as a result of the tender process. If a tenderer fails to comply with the Code, the Principal may take the failure into account when considering this or any subsequent tender from the tenderer, and may pass over such the tender.
[bookmark: _Toc182198327]Goods and Services Tax
Fees, rates and other amounts in this Tender must include GST if it is payable.  
[bookmark: _Toc182198328]Submission of Tender
Documents to be submitted
The following documents need to be completed and submitted by the Tenderer:
Tender Form
Other Tender Schedules
List any other returnable documents.
if none, remove the prompt.
»
Submit all information called for in the tender documents.
Delete the following paragraph when Conditions of Tendering clause Alternative Tenders disallows an alternative tender.
Where any alternative tender is offered, submit alternative Tender Schedules describing where the alternative tender(s) differ from the conforming tender.  Identify each schedule and the alternative to which it applies.
End of paragraph.
Where applicable, refer to each Addendum and state that the Tender allows for the instructions given in the Addendum.
Delete the following paragraph if not applicable.
General information about your firm, such as brochures and the firm's history, is not required with the Tender.
End of paragraph.
Submission procedure
Submit the Tender Form, Tender Schedules marked “Submit with the Tender Form” and other required documents or information by the date and time given in the advertisement or invitation, by any of the following methods:
delete any method not applicable
ETendering;
Tender Box;
Facsimile.
If more than one tender submission is made, mark each submission clearly as to whether it is a copy, an alternative tender, or whether the submission supersedes another submission.
Submit when requested, by the date, time and method stipulated in the request, Tender Schedules marked “Submit when requested” and any other information required to allow further consideration of the Tender.  Failure to meet this requirement may result in the Tender being rejected.
[bookmark: _Toc182198329]eTendering
delete this clause and the above heading if this method is not used.
agencies are expected to use etendering where possible.
an agency may establish an etendering site or make arrangements to use the Department of finance & Services ETendering site through
nswbuy@services.nsw.gov.au.
The NSW Government electronic Tendering system has the capacity to allow viewing of documents, downloading or ordering of Requests for Tender (RFT) and submission of tenders.
Tenderers are encouraged to obtain RFT and submit tenders through the eTendering website at: https://tenders.nsw.gov.au/ .
Two envelope system
Delete this Sub-clause and the above Sub-heading when the Two Envelope system not Used.
Use the two envelope system when the estimated fee is more than $150,000
The Tender must submitted be in two separate files. The first file is for Tender Schedules and other documents containing non-price elements. The second file is for the Tender Form and other Tender Schedules containing price elements. Each file must have a cover sheet with the appropriate identifier:
“Tender for »    - Envelope 1: Non-price data”
“Tender for »    - Envelope 2: Price data”
Each separate file may be more than one file zipped and named appropriately. The separate files may be lodged together or in separate actions.
end Sub-Clause - two envelope’ system.
Legal status
Tenders submitted electronically will be treated in accordance with the Electronic Transactions Act 2000 (NSW), and given no lesser level of confidentiality, probity and attention than tenders submitted by other means.
Signatures are not required for a Tender submitted electronically.  A tenderer must ensure that a Tender is authorised by the person or persons who may do so on behalf of the Tenderer and appropriately identify the person and indicate the person’s approval of the information communicated.
Tenderers, by electronically submitting a tender, are taken to have accepted any conditions shown on the NSW Government eTendering web site.
The Principal may decline to consider for acceptance, tenders that cannot be effectively evaluated because they are incomplete or corrupt.
Electronic format for submissions
Tenders submitted electronically must be in a file format that can be read, formatted, displayed and printed by Microsoft Word 2000, or any format required by the RFT.
File compression
Tenderers may compress electronic tenders in any format that can be decompressed by WinZip. Tenderers must not submit self-extracting (*.exe) zip files.
Change of Tender Form text
Tenderers must not change existing text in electronic tender forms other than to insert required information.
End of Clause - ETendering.
[bookmark: _Toc182198330]Tender Box
delete this clause and the above heading if this method is not used.
the tender box must be approved for use by the agency responsible for the project.  
arrangements may be made to use the department of Services, Technology & Administration tender Box through tenders@commerce.nsw.gov.au.
The Tender may be submitted in the Tender Box at:
Insert the name and address of the tender closing office.
»
Insert the name of the contract in the following paragraph
Submit the Tender in a sealed envelope addressed to the Secretary of the Tender Opening Committee and marked with “Tender for »” and the closing date and time.
Use the following provision for tenders using the two envelope system (estimated fee over $150,000). Otherwise delete.
Start of provision
The Tenderer must:
enclose all (and only) the Tender Schedules and other documents containing non-price elements of the Tender in an envelope sealed and labelled - "Envelope 1: Non-price data";
enclose all (and only) the Tender Form, other Tender Schedules and other documents containing price elements of the Tender in another envelope sealed and labelled "Envelope 2: Price data", and
submit Envelope 1 and Envelope 2 inside the sealed envelope addressed and marked as described above.
End of provision
End of Clause - Tender Box
[bookmark: _Toc182198331]Facsimile
delete this clause and the above heading if this method is not used.
the facsimile number must be approved for use by the agency responsible for the project.
The Tender may be submitted to the following facsimile number:
Insert the facsimile number of the tender closing office.
»
Insert the name of the contract in the Following paragraph
Address the Tender to the Secretary of the Tender Opening Committee and mark the first page of the facsimile with “Tender for »”, and the closing date and time.
Use the following provision for tenders using the two envelope system (estimated fee over $150,000). Otherwise delete.
Start of provision
Submit separately the set of Tender Schedules and other documents containing non-price elements, and the set of Tender Form, other Tender Schedules and other documents containing price elements. Each set must have a cover sheet addressed and marked as above with the appropriate additional identifier:
“Envelope 1: Non-price data”;
“Envelope 2: Price data”
End of provision
Tenders sent by facsimile and not completely received at one of the specified locations by the close of tenders, may be excluded from consideration for acceptance even if transmission or receipt is delayed due to the receiving facsimile machine being engaged, faulty or otherwise inoperative.
End of Clause - Facsimile
[bookmark: _Toc182198332]Late Tenders
In accordance with the NSW Government Code of Practice for Procurement, late tenders will not be accepted, except where the integrity and competitiveness of the tendering process will not be compromised.
Late tenders will generally not be considered for acceptance if they are:
hand delivered, including courier deliveries; or
received by an electronic communication despatched after close of tenders.
[bookmark: _Toc182198333]Alternative Tenders
Select either option 1 or  2 or 3 below and delete the two options not selected.  
Option 1 disallows any alternative tender.
Option 2 allows the Tenderer the option of submitting an alternative, provided a fully compliant tender for the work specified in the Agreement is also submitted.
Option 3 permits submitting tenders with unspecified alternatives.
[Start option 1]
Submit a single Tender in full compliance with the work as specified without any conditions or qualifications.
[End option 1]
[Start option 2]
You must submit a Tender that fully complies with the Agreement’s specifications without any conditions or qualifications attached.  You may also submit alternative Tenders.  If so, you must fully describe and price any conditions, qualifications, or departures from the specification for the alternative Tender.
[End option 2]
[Start option 3]
Submit one or more Tenders for the work.  You must fully describe and price any conditions, qualifications or departures from the specification in the Tenders.
[End option 3]
Mandatory Alternative Tenders
delete this Sub-clause and the above heading if Mandatory Alternate Tenders are not required.
Insert a list of mandatory alternative tenders where these are sought.  These may only be for alternative completion times.
When alternative tenders are mandatory, describe and specify relevant details, such as:
The information to be submitted with an alternative tender.
Technical or other references in the briefing documents.
The Tenderer's obligation to detail the effect of an alternative tender.
»
End of Sub-clause - Mandatory Alternate Tenders.
Optional Alternative Tenders
delete this Sub-clause and the above heading if Optional Alternate Tenders are not required.
Insert a list of optional alternative tenders where these are sought.
When alternative tenders are permitted, describe and specify relevant details, such as:
The information to be submitted with an alternative tender.
Technical or other references in the briefing documents.
The Tenderer's obligation to detail the effect of an alternative tender.
»
End of Sub-clause – Optional Alternate Tenders.
Unacceptable Alternative Tenders for Elements of Work
delete this Sub-clause and the above heading if Unacceptable Alternative Tenders for Elements of Work are not required.
The following aspects of the work will not be considered acceptable in alternative Tenders:
List areas or elements for which alternative tenders will not be considered.
»
End of Sub-clause – Unacceptable Alternative Tenders for Elements of Work
[bookmark: _Toc182198334]Assessment and Acceptance of Tenders
Include the Following paragraph if sections of the work may be awarded separately.  Follow this with a list of engagements that may be separately awarded, otherwise delete.
Tenders may be accepted for the whole of the work or specific sections as follows:
»
End of Paragraph.
The criteria for assessment of Tenders are:
Insert the weightings, for example: Price 40%, Non-price 60%.
See Procurement Practice Guide Tendering process for consultancy services engagements for guidance on criteria weightings.
Price (weighting »%)
- Fee
DELETE “RATES FOR VARIATIONS” IF NOT REQUESTED IN THE TENDER DOCUMENT.
- Rates for variations
See Procurement Practice Guide Tendering process for consultancy services engagements for guidance on selecting appropriate criteria.
Non-price (weighting »%)
Insert non-price criteria to be used.
- »
Assessment of criteria will be based on information provided in the Tender Schedules. 
Tenders considered unsatisfactory for any of the criteria may not be considered further.
Include the following paragraph when the engagement involves design or design management, otherwise delete
Tenderers with a quality management system certified as meeting the requirements of AS/NZS ISO 9001:2008 or ISO 9001:2008 receive a 10% price preference over those without a quality management system so certified.
End of paragraph
Note that for any engagement with Fee exceeding $30,000 where there is no prequalified panel, you must make every effort to invite tenders from Tenderers with quality management systems certified as meeting AS/NZS ISO 9001:2000 or ISO 9001:2000 requirements.  Only when this proves impractical or regional/local consultants may be suitable can you include tenderers who do not have quality management systems so certified.
Any Tender may be rejected if it does not comply with any requirement of the Tender Document, or if it contains provisions not required or allowed by the Tender Document.
Tenderers must not consider that their Tender has been accepted unless and until they receive written notice of acceptance, either delivered or transmitted by fax to the Tenderer’s fax number.
[bookmark: _Toc182198335]Acceptable Legal Entities
The Principal contracts only with recognised and acceptable legal entities with appropriate financial assets and current professional indemnity insurance cover.  Tenders will not be considered from entities such as business names.
Tenderers may be required to provide evidence of their legal entity, by submitting a copy of an official document such as:
Company registration and names of office bearers issued by the Australian Securities and Investments Commission, or
A statement confirming the legal entity signed by a practicing solicitor.
If requested to do this, submit the information within three working days of receiving the request.
[bookmark: _Toc182198336]Financial Capacity
DELETE THIS CLAUSE AND THE ABOVE HEADING UNLESS:
THE AGREEMENT IS FOR A LONG TERM; AND
THERE IS CONCERN THAT A TENDERER LIKELY TO BE IN CONTENTION MAY NOT BE EITHER PREQUALIFIED UNDER THE CONSULTANT PREQUALIFICATION SCHEME OPERATED BY THE DEPARTMENT OF SERVICES, TECHNOLOGY & ADMINISTRATION OR KNOWN BY THE RESPONSIBLE AGENCY TO BE SUITABLE; AND 
A MANAGER WITH THE APPROPRIATE AUTHORITY HAS GIVEN APPROVAL TO INCLUDE THE CLAUSE.
Tenderers must have sufficient financial capacity to perform the services required under the Agreement. Tenderers do not need to provide financial statements.
If requested to do so, Tenderers must provide a statement from a qualified accountant certifying that the Tenderer has met:
all of its statutory obligations including payment of pay as you go taxation instalments, PAYG withholding tax, GST Business Activity Statements, Superannuation Guarantee payments and payment of payroll tax, if applicable; and
other obligations including payment of rentals and interest, as well as payment of sub-contractors, subconsultants and suppliers within acceptable business credit periods.
End of clause - Financial Capacity
[bookmark: _Toc182198337]Sub-Consultants
DELETE THIS CLAUSE AND THE ABOVE HEADING UNLESS:
The tender is likely to include significant sub-consultant packages with fees greater than $50,000; or 
sub-consultant work critical to the engagement.
For each sub-consultant service listed below, nominate in the Outline Services Delivery Plan the sub-consultant you propose to do the work.  
List the relevant sub-consultant packages.
»
End of clause - Sub-Consultants
[bookmark: _Toc182198338]Disclosure of Contract Information
Details of this tender and the contract awarded as a result of this tender process must be disclosed in accordance with the Government Information (Public Access) Act 2009 (NSW), Premier’s Memorandum 2007-01 and the NSW Government Tendering Guidelines, available at:
http://www.nswprocurement.com.au/Procurement-System-for-Construction/Reference-material/Procurement-Guideline-Documents.aspx
[bookmark: _Toc182198339]Consultant Performance
During the consultancy Agreement, the Consultant's performance is monitored in accordance with Procurement Practice Guide Performance management.  Unsatisfactory performance is taken into account when considering future opportunities for consultant Agreements for NSW Government Agencies.
[bookmark: _Toc182198340]Multiple Use of Contract Material
DELETE THIS CLAUSE AND THE ABOVE HEADING UNLESS multiple use of the contract material is intended or may occur.
The contract material may be adapted or changed by the Principal for the purpose of construction of similar facilities on the same or a different site.  Refer to Clause 7.3 of the Consultant Agreement.
End of clause - Multiple Use of Contract Material
[bookmark: _Toc182198341]Using Asset.gov
If Asset.gov is not to be used for services communication, delete the above heading and the related clauses below, and do not use the Appendix Asset.gov
A communications module (http://asset.gov.com.au/default.asp) called “Asset.gov” is a project management data-base tool that is enabled over the Internet, providing a secure environment for the transmission of and access to electronic documents between and by the successful Tenderer, other participants in the project delivery process, and the Principal.  See the Appendix “Asset.gov”. 
If requested by the Tenderer, a demonstration of the use of Asset.gov for projects will be given at a time and place notified by the contact person.
End of clause - Using Asset.gov
[bookmark: _Toc182198342]Other Matters
Include in this section any other conditions that may apply.
If none then delete heading and prompt
»

Insert the Name of project and/or contract and theContract No.
The details must match those on the title page
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